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Overview 

General 
The Michigan Syndromic Surveillance System (MSSS) is a real-time surveillance system that tracks 
the chief presenting complaints from healthcare providers allowing public health officials and 
providers to monitor trends and investigate unusual increases in symptom presentations. MSSS 
receives syndromic data from hospital emergency departments and urgent care centers (i.e., 
emergent care). MSSS currently does not accept data from non-urgent care settings and has no 
plans to accept messages for inpatient data. 

MSSS provides real-time situational awareness of potential public health threats and emergencies. 
The system sends alerts to Michigan public health officials when unusual increases in symptom 
presentations are detected, and Michigan Department of Health and Human Services (MDHHS) 
epidemiologists can analyze findings, investigate further, and contact local public health agencies 
and providers. 

The HL7 messages received by MSSS are in an industry-standard electronic data format used to 
transmit healthcare data. Messages consist of patient information, visit information, and chief 
complaint. The chief complaint is categorized currently into one of ten syndromes using an 
algorithm based on keywords. CoCo, the Bayesian chief complaint classifier used in MSSS, applies 
an algorithm that categorizes the data, matches key phrases (e.g., chest pain, nausea) into one 
(and only one) of the categories. The syndrome category of “Default” receives those that are 
unassigned. 

Chief Complaint. Chief complaint values are stored in the database exactly as they are received 
by MSSS. However, the following changes are made—in the order shown below—prior to being 
sent to the Syndromic Classifier: 

1. The string is converted to lowercase; 

2. All non-word characters (i.e., those not in the set [a-zA-Z_0-9]) are replaced with a single 
space; 

3. All groupings of more than one space are replaced with a single space; and 

Chief complaint data is concatenated (i.e., merged) when a single syndromic message contains two 
or more OBX segments with Chief Complaint values. The chief complaint values are concatenated 
with a tilde ("~") separating them (with no attempt made to remove any tilde that may exist in any of 
the values). Currently, the only source for chief complaint is an OBX segment with the following 
characteristics, but there can me more than one of these of either style within a single message: 

1. OBX.2 = TX and OBX.3 = 8661-1 loads OBX.5.1 
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2. OBX.2 = CWE and OBX.3 = 8661-1 loads OBX.5.9 

3. All whitespace at the front and rear of the string is removed. 

Syndromic categories. The ten syndromic categories currently in MSSS include: Gastrointestinal, 
Constitutional, Respiratory, Rash, Hemorrhagic, Botulinic, Neurological, Heat, Other, and Default. 
The list below provides a sample of the key words (including common misspellings) used to 
categorize symptoms into the nine (plus default) syndromes.  

Syndrome Keywords 

Gastrointestinal 

 

Abdominal, stomach, epigastric, gastric, gastritis, enteritis, appendicitis, diarrhea, 
vomiting, vomitting, nausea, n, v, rlq, abdomen, abd, crohns, gerd, diverticulitis, 
gastroenteritis, emesis, hyperemesis, poisoning, pud, peptic, ruq, llq, luq, nv, nvd, 
gastrointestinal, ab, abdmnal, abdominalpain, diaherra, gastrointest, vom, 
vomitinghyperemesis, vomitng 

Constitutional Fever, weakness, dizziness, dizzy, temp, flu, influenza, flulike, lightheaded, chills, 
lethargy, fatigue, weak, sweating, lethargic, febrile, constitutional 

Respiratory Cough, ribs, breath, wheezing, croup, pharyngitis, respiratory, thrt, st, congestion, 
shortness, rib, strep, throat, cold, bronchitis, pneumonia, copd, asthma, sob, tonsillitis, 
breathing, sinus, sinusitis, uri, dyspnea, resp, dib, pneumonitis, pleural, pleurisy, 
airway, sorethroat, coughing, congested, breathe, breather, db, nasopharyngitis, 
shortnessofbreath, whez 

Rash Rash, urticaria, hives, bumps, petechiae, purpura, ivy, dermatitis, pox, scabies, spots, 
shingles, boils , erupt 

Hemorrhagic Epistaxis, bleeding, hemoptysis, hematuria, hematemesis, blood, bleed, hematochesia, 
hemorrhagic, hemorrhaging, bleeds, bloody, epitaxis, hemorr, nosebleed 

Botulinic Slurred, diplopia, dysphagia, photophobia, dysarthria, speaking, swallowing, blurred, 
blurry, swallow, botulinic 

Neurological Migraines, memory, headpain, migrane, migrain, disoriented, disorientation, passed, 
syncopal, palsy, fainting, paralysis, tingling, seizures, headaches, cephalgia, stroke, 
tia, cva, ha, headache, migraine, seizure, convulsion, syncope, fainted, loc, mental, 
vertigo, meningitis, numbness, numb, h, confused, confusion, dementia, unresponsive, 
dizziness, dizzyness, unconscious, dizzy, sz, blacked, consciousnes, consciousness, 
convulsions, migrne, szr, neurologicaldeficit, siezure, syncopy, neurological 

Heat Dehydration, dehydrated, dehydrate, dehydrat, dehydraton, heat, heatstroke, 
overheating, overheated, heating, heated, sun, sunburn, sunburnt, sunburned, 
hyperthermia, sunstroke, heat rash, heat exhaustion, heat stroke, over heated, heat 
exposure, heat related, heat exhaust, over heating, heat cramps, heat illness, heat 
issues, heat bumps, sun burn, sun poisoning, sun burned, sun blisters, sun reaction, 
heat syncope, heat fatigue 

Other Lac, mva, laceration, cnt, contusion, contusions, fx, broken, sprain, bee, injury, inj, 
mvc, bite, fb, abrasion, wound, suture, crisis, injured, doi, concussion, physical, pe, 
pressure, fall, sugar, gsw, fell, monoxide, attack, flash, palpitations, rate, racing, 
flashes, pad, pack, vent 

Default Everything else (default category) 

 MSSS Syndromes and Keywords  
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Getting Started 

Text Conventions 
Text throughout this manual is marked with specific styles for clarity. The Text Conventions Table 
describes these different styles. 

Text Conventions Table 

Element Text Style Example 

File names and directories Courier Run the setup.exe file. 

Menu names and buttons Bold Click Save. 

Screen/Page names Italics The EpiPlot screen 

Names of Edit Fields, 
Check Boxes, and List 
Boxes 

Initial caps In the Name field, type the 
new value. 

Links Underline Select the Next link. 

Names of keyboard keys Small caps Press ENTER to activate 
the screen. 
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Accessing the Syndromic Surveillance System 
 

The Michigan Syndromic Surveillance System is a Web-based application. In order to access it, you 
must 

1. Have access to the State of Michigan (SOM) MILogin. 

2. Request access to the Michigan Syndromic Surveillance System application. 

3. The Michigan Syndromic Surveillance System Administrator must approve your access. 

4. Once approved, click the Michigan Syndromic Surveillance System application link. 

State of Michigan (SOM) MILogin 
 

The MILogin interface provides safe access to SOM applications, including MSSS. Your access 
links and home page will differ depending on if you are a SOM employee or contractor (i.e., third 
party). Get your appropriate MILogin link from your supervisor or work team. 

 
MILogin page 
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All users who have access to MSSS will access the system through this login screen. Enter your 
User ID and password and then click the LOGIN button. If you are not a registered user for 
MILogin, Click the SIGN UP button.  

Once logged in, you will see the SOM applications you can access. If the Michigan Syndromic 
Surveillance System application is not listed, click the REQUEST ACCESS menu item. 

 
MILogin Home showing the MSSS application link 

Click the Michigan Syndromic Surveillance System application link to access MSSS.  

You will first need to agree to the terms and conditions before using MSSS. Read the usage 
requirements and then click Acknowledge/Agree. 
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MSSS Terms & Conditions for usage 

The Michigan Syndromic Surveillance System opens in a separate window. As described in the 
Logout section, you must log out of both MSSS and MILogin separately. 
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Main 

Main Screen 
The Main screen is the default page in MSSS. This page appears after you click the application link 
and agree to the terms and conditions of usage. You can also return to this page by clicking Main in 
the top menu. 

 

 

 
Syndromic Surveillance Main Screen 

The page shows the total number of registrations in the past week and charts for each primary 
syndrome (syndromes “Other” and “Default” are not shown) over the same time period.  

 The graphs are populated with emergent data totaled at the State level by default, but the 
view can be changed using drop-downs at the page bottom.  

 The y-axis of each graph shows the number of registrations and the x-axis shows the date.  
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 Each graph represents activity for the past week (i.e., preceding seven days). 
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Changing Views 
 

By default, the Main page is loaded with data at the State level, but you can change to individual 
counties or a state normalized view.  

  
Bottom Frame of the Main page 

 

To Change Views: 

1. Charts. Select the desired chart aggregation from the drop-down list. 

a. State Totals – Data totaled at the State level. 

b. State Normalized – Data normalized at the State level. Note: When “State 
Normalized” is selected, it applies to all counties. Use Epiplot for more specific 
normalizations. 

c. Individual Michigan County – Data displayed represents just the selected county. 

2. Click the Change View button. 
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Epiplot 

Epiplot Screen 
Click the Epiplot menu item from any page to access the Epiplot functionality. The following screen 
appears. 

 
Epiplot Screen 

The Epiplot screen lets you filter, plot, and download syndromic data on a graph, given a variety of 
user defined parameters. Two graphing areas are available to allow side-by-side graph 
comparisons. Initially, the screen appears without graphs displayed. 

Epiplot View Controls: 

 Filter – Filter controls are available to allow additional criteria to filter the data being plotted 
or downloaded. 

o Filter – This drop-down list contains all the saved filters regardless of user. 

o FilterName – This text box lets you assign a name when saving a filter. 
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o AND – This provides the AND criteria for the filter query. 

o OR – This provides the OR criteria for the filter query. 

o NOT – This provides the NOT criteria for the filter query. 

 Pending Features – This is a status box indicating whether the specified parameters have 
been applied and to which graph area or download. The following is a list of the status box 
values and their meanings: 

o Pending Features means the parameters have not been applied yet.  

o Left Plot Features means that the currently displayed parameters have been applied 
to the left graph. 

o Right Plot Features means that the currently displayed parameters have been 
applied to the right graph. 

o Download Plot Features means that the currently displayed parameters have been 
applied to the downloaded data. 

 Data Source – Enables you to select Emergent Data (initially selected), Poison Data, or 
Health Information Exchange (HIE) Data (i.e., more robust Meaningful Use Stage 2 [MU2] 
data format arriving through local HIEs and the Michigan Health Information Network 
[MiHIN]). 

 Plotting Preference – Lets you use Advanced Plot (initially selected) or Basic Plot. Advanced 
plotting provides additional plot features such as moving averages, tool tips, and alert 
plotting. Select the State Levels checkbox when plotting county data to graph statewide data 
also on your chart. 

 Period – Pre-defined time periods (i.e., Last week, Last month, etc.) or a custom time period. 

 Start – Date to start plotting from. 

 End – Date to stop plotting from. 

 Aggregation Level – Lets you select the aggregation level of the graph. Rolling 24-Hour 
Aggregation uses the current user time as the basis for 24 hour aggregates, whereas Daily 
Aggregation uses calendar dates. Weekly Aggregation aggregates the data on a weekly 
basis—creating a rolling seven-day aggregation without respect to time. It is based on the 
selected end date, moving backward 

 Interval – Only applies to the Rolling 24-Hour Aggregation selection and lets you define the 
ending point of the 24-hour window. 

 Normalize – Normalization is the number of visits assigned to a particular syndrome divided 
by the total number of visits. Selecting this check box lets you normalize the data before 
plotting it. In order to enable the Normalize check box, one or more syndromes must be 
selected (but not All Healthcare Visits). Note: When a county and a syndrome are selected, 
the normalization is with respect to the county. When only a syndrome is selected (i.e., 
Michigan is selected instead of one or more counties), the normalization is with respect to 
the entire state. 
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 Strict Zips – Select this check box to alter the selection criteria for EpiPlot and downloads as 
follows: 

o Match records using the first 5 characters (zip5) of the reported zip (instead of using 
the calculated Assigned Zip). 

o Eliminate records whose reported zip5 are not known Michigan Zips. 

o Populate the “Valid” column in the download correctly. 

 Gender – Allows you to select one or both genders. 

 Age Group – Lets you select all ages or a particular age grouping. If you select Custom, the 
Min and Max fields are available for user definition. 

o Min – Minimum age to include in the data set. 

o Max – Maximum age to include in the data set. 

 Syndrome – Lets you plot all Healthcare visits or a variety of syndromes. 

 County – Enables you to plot all Michigan counties or a variety of counties. 

 Facility – Allows you to select to plot all facilities or a variety of facilities. 

 Left / Right – Lets you generate a chart in the left or right screen area based on your 
selected parameters. While the chart is being generated, the button you clicked is replaced 
with a Cancel button in case you want to end the charting process. Hovering your cursor 
over the Cancel button reveals a stopwatch count, showing the elapsed time since the 
command was initiated.  

 Download – Generates a data set (the same used for charting with the Left/Right buttons) 
download based on your selected parameters that you can view or save. Selecting the 
Extended Format checkbox downloads a larger data set with additional fields, which will 
cause it to take longer than the “normal” download. 

 Help – Shows this User Manual in an online Help format.  
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Filtering Data 
 

Filtering allows the user to limit the registrations included in the plot or data downloaded by the 
words and or phrases specified as filter criteria. By default, the Epiplot screen does not have any 
filters applied. The Pending Features status box will indicate to which area the currently selected 
parameters have been applied. “Pending Features” means the current selections have not yet been 
applied.  

 

 

Bottom Frame of the Epiplot Screen 

To Filter Data: 

1. Select a saved filter from the Filter drop-down list or create a new one by typing criteria in 
one or more of the criteria text boxes. 

a. FilterName – Type a unique name for your filter. Note: You cannot overwrite a filter 
created by another user and filter names must be unique. 

b. AND – Type a combination of one or more words or phrases that must all be 
included in the chief complaint text of the registration. See the important rules below. 

c. OR – Type additional words or phrases that appear as part of the chief complaint text 
of the registration. See the important rules below. 

d. NOT – Type a combination of one or more words or phrases that cannot appear in 
the chief complaint text of the registration. See the important rules below. 

2. Click the Validate button. This will validate that the filter criteria has been properly specified 
for plotting or downloading. 

Important Rules for Entering Filter Text:  

 When typing in words or phrases in the filter criteria text boxes (AND, OR, or NOT), enter 
words without double quotes.  

 Use double quotation marks when adding multiple words (i.e., phrases) to indicate the 
beginning and end the whole phrase—note that to find it, the full phrase must appear in the 
chief complaint text exactly as typed.  

 Separate words and phrases with a space.  
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 If the query is not valid, an error message will appear. For example, the use of single quotes 
is prohibited.  

To Save Filters: 

1. Select a saved filter from the Filter drop-down list or create a new one by typing criteria in 
one or more of the criteria text boxes. 

2. Enter a unique name for the filter. 

3. Click the Save button. Note: You cannot overwrite a filter created by another user. 

To Delete Filters: 

1. Select a saved filter from the Filter drop-down list. 

2. Click the Del button. Note: You cannot delete a filter created by another user. 

To Clear Filter Criteria: 

1. Click the Clear button. This will clear all the filter text boxes. 
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Plotting Filtered Data 
 

Filtering—using words and or phrases specified as filter criteria—allows you to limit the registrations 
included in the plot or data downloaded. 

To Plot Filtered Data: 

1. Select a saved filter from the Filter drop-down list or create a new one. 

2. Validate the filter if a new filter was created. If the filter was valid, a window will pop-up 
displaying the first 10 records of the resulting query (if any). 

3. Click the Left or Right button. The filter criteria text is used to limit the registrations included 
in the graph. 

Simple Example Plotting Filtered Data: Type sore throat in the AND filter criteria text box. 

1. Click the Validate button. The following screen appears (though it will be blank until the 
validation processing is complete). Close the window when done. 

 

Validating a Simple Filter 

2. Click the Left button. The filter criteria text will be used to limit the registrations included in 
the graph. 
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Simple Example of Plotting Sore Throat Data 

Complex Example Plotting Filtered Data: 

1. Type the word asthma in the AND filter criteria text box. 

2. Type the words attack and cough, separated by a space, in the OR filter criteria text box. 

3. Type the phrase “difficult breathing” with the double quotation marks in the NOT filter 
criteria text box. 

4. Click the Validate button. The following screen appears. 
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Validate Complex Filter 

 

5. Click the Left button. The filter criteria text will be used to limit the registrations included in 
the graph. 

 

Complex Example Plotting Asthma Data 

In this example, the registrations have been limited to ones with the words “asthma” and “attack” 
included in the chief complaint, excluding those that contain the phrase “difficult breathing.” Also 
included will be registrations with the words “asthma” and “cough” included in the chief complaint 
that do not include the phrase “difficult breathing.” 
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Plotting Data 
 

By default, the Epiplot screen is not loaded with any data but default selections have been made. 
The Pending Features status box will indicate to which area the currently selected parameters have 
been applied. “Pending Features” means the current selections have not yet been applied.  

 

 
Bottom Frame of the Epiplot Screen 

 

To Plot Data: 

1. Select the desired chart parameters. 

a. Filter – To apply a filter, select a saved filter from the Filter drop-down or create a 
new one. 

b. Data Source: 

i. Emergent Data – Emergency Department and Urgent Care data 

ii. Poison Data – Poison data. Note: Poison data is not received in real-time. It 
has a 24-hour (+/-) reception cycle. 

iii. HIE Feeds – Data arriving in the Meaningful Use Stage 2 format through local 
health information exchanges (HIEs) and MiHIN. Selecting this excludes data 
arriving in the “legacy” format. 

c. Plotting Preference: 

i. Advanced Plot – Provides additional graph features. 

1. Moving Average – This additional line on the graph provides a moving 
average over a seven-day period (for comparison). 

2. Tool Tips – The graph provides tool tips when you hover over areas 
on the graph. Points on the graph as well as any alerts will provide 
you detailed information about that point on the graph (such as day 
and amount). 

3. Alert Plotting – If an alert appears on the graph, you can hover over 
either of the two alert markers to get the date/time of the alert, 
syndrome name, the extent and threshold of the alert, and the option 
to click for more details. Note that the visual distance between the two 
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alert markers indicates the relative size of the delta but do not have 
any chart units associated with them. The wider apart the alert 
markers are, the bigger the event. 

a. Hover over the upper (bell-shaped) alert marker—which 
represents the alert extent—on the blue Registrations line to 
see alert details and a clickable link to open the associated 
Chronology chart in the opposite frame. The alert extent is 
shown in the tooltip as the number immediately following the 
syndrome name. 

  

b. Hover over the diamond-shaped alert marker—which 
represents the alert threshold—to see alert details and a 
clickable link to open the associated graph with a month’s 
worth of data. The alert threshold is shown in the tooltip as the 
number in parentheses and is the value that must be 
exceeded for an alert to fire. 

 

ii. Basic Plot – Provides basic graph features. 

iii. State Levels checkbox – Lets users add state-level data to the graph when 
county data is charted. When selected, it adds a series to the resulting chart 
that shows the statewide performance with all other parameters being equal. 
This provides a comparison between the State-level activity and the selected 
county. 

d. Period: 

i. Select one of the available time periods (e.g., Today, Last 2 Weeks, Last 
Year) or choose Custom Dates to define your own. If you select a time period 
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from the list, the Start and End fields fill in automatically. If you change the 
start or end dates, the Period selection automatically changes to Custom 
Dates. 

ii. Start – Select the month, day, and year to start pulling data. These fields fill in 
automatically if you select a defined period, but you can edit them manually 
also. 

iii. End – Select the month, day, and year to stop pulling data (includes this day). 
These fields fill in automatically if you select a defined period, but you can 
edit them manually also. 

e. Aggregation Level: 

i. Daily Aggregation – Aggregates the data on a daily basis. This aggregates by 
admission date, without respect to time. It is based on the selected end date, 
moving backward. 

ii. Weekly Aggregation – Aggregates the data on a weekly basis. This creates a 
rolling seven-day aggregation, without respect to time. It is based on the 
selected end date, moving backward. 

iii. Rolling 24 Aggregation – Aggregates the data on a rolling 24-hour window. 
This is based on the specified interval. Intervals have a granularity of thirty 
minutes. The default interval is the current time when the graph is displayed 
or refreshed. The cardinality of each point on the graph is the total number of 
admissions received (with respect to all other graphing parameters) in the 24-
hour period. 

f. Interval: Applies to the Rolling 24-Hour Aggregation level. The ending time of the 24-
hour window. 

g. Normalize: 

i. Checked – Data will be normalized, which shows the number of visits 
assigned to a particular syndrome divided by the total number of visits. Note: 
Epiplot normalization includes out-of-state or unknown zip codes, whereas 
the Mapping component and Alert components do not. Unknown zip codes 
are assigned the zip code of the facility in which the registration occurred. 

ii. Unchecked – Data will be raw 

h. Strict Zips:  

i. Unchecked –Data selection uses the “standard process” for assigning 
encounter Zips to the treatment facility’s Zip when the patient’s home Zip is 
missing or not a known Michigan Zip. 

ii. Checked – Data selection matches records using the first 5 characters (zip5) 
of the reported Zip (instead of using the calculated Assigned Zip) and 
removes records whose reported zip5 are not known Michigan Zips. 

i. Gender: 
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i. Male & Female – Data will contain both genders 

ii. Male – Data will contain only male 

iii. Female – Data will contain only female 

j. Age Group: 

i. All Ages – Data will contain all ages 

ii. Youth – Data will contain only patients from 0 to 17 

iii. Adult – Data will contain only patients from 18 to 130 

iv. Custom – If you select Custom, the Min and Max fields are available for user 
definition. 

1. Min – Minimum age to include in the data set (0+) 

2. Max – Maximum age to include in the data set 

k. Syndrome: 

i. All Healthcare Visits 

ii. Multiple Syndromes – Use the CTRL or SHIFT key in combination with the 
mouse to multi-select any combination of syndromes. 

1. Gastrointestinal 

2. Constitutional 

3. Respiratory 

4. Rash 

5. Hemorrhagic 

6. Botulinic 

7. Neurological 

8. Heat 

9. Other 

10. Default 

l. County: 

i. Michigan – all Michigan counties included. 

ii. Multiple Counties – Use the CTRL or SHIFT key in combination with the mouse 
to multi-select any combination of counties. 
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m. Facility: 

i. All Facilities 

ii. Multiple facilities – Use the CTRL or SHIFT key in combination with the mouse 
to multi-select any combination of facilities. 

2. Click the Left/Right button. If the left button was selected, the graph on the left-hand side 
will be loaded. If the right button was selected, the graph on the right-hand side will be 
loaded. 
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Printing Graph Data 
 

  
Sample Epiplot Graph 

 

Once a graph has been plotted, you can print it.  

To Print Graph Data: 

1. Plot a graph. 

2. Click the Print button on the bottom of the desired graph screen (left or right). 



Michigan Syndromic Surveillance System User Manual November 2017  24 
 

Downloading Data 
 

The Download button lets you save data and graphs to your hard-drive. You can download a 
“normal” data set, which has been available for years, or in an extended format with additional data 
elements. Because they contain more data per record, extended format downloads will take longer 
to process than the normal format downloads.  

A single file, named EpiPlot.zip, is saved to the location you specify. This zip file contains three 
files: Cases, Points, and Chart. The Cases.csv files differ depending on if you select to download 
the extended format. Both Cases.csv formats are shown below: 

 Cases.csv (normal) – This file contains the registration information the meet the selected 
criteria in a comma-separated file. The normal format file contains the following information: 

a. Admitted – admitted date/time 

b. Facility – abbreviated name of the hospital 

c. Assigned Zip – the patient’s “perceived” zip code, which is either the patient’s 
reported home zip (if a valid Michigan zip code) or the treatment facility’s zip code if 
the patients’ reported zip is missing or a non-Michigan zip  

d. Reported Zip – the actual patient’s home zip code submitted in message data 

e. Valid – a Y/N indicator as to whether the zip code is a valid Michigan zip code 

f. Assigned County – the FIPS county code associated with the Assigned (i.e., 
perceived) Zip, so it is either the county code of the patient’s home address (if a valid 
Michigan zip) or the county code of the treatment facility (in the absence of a valid 
Michigan Zip for the patient). 

g. Gender – M/F/U 

h. Age – age at the time of admission 

i. Syndrome – the syndrome classification 

j. Provider – the treatment facility name 

k. Provider ID – ID of the treatment facility 

l. Organization – the organization that the treatment facility belongs to 

m. Org ID – ID of the organization 

n. Complaint – chief complaint 

 Cases.csv (extended) – This file contains the registration information the meet the 
selected criteria in a comma-separated file. The “extended format” file contains the following 
information: 
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a. Admitted – admitted date/time 

b. Facility – abbreviated name of the hospital 

c. Assigned Zip – the patient’s “perceived” zip code, which is either the patient’s 
reported home zip (if a valid Michigan zip code) or the treatment facility’s zip code if 
the patients’ reported zip is missing or a non-Michigan zip 

d. Reported Zip – the actual patient’s home zip code submitted in message data 

e. Valid – a Y/N indicator as to whether the zip code is a valid Michigan zip code 

f. Assigned County – the FIPS county code associated with the Assigned (i.e., 
perceived) Zip, so it is either the county code of the patient’s home address (if a valid 
Michigan zip) or the county code of the treatment facility (in the absence of a valid 
Michigan Zip for the patient). 

g. Gender – M/F/U 

h. Age – age at the time of admission 

i. Syndrome – the syndrome classification 

j. Provider – the treatment facility name 

k. Provider ID – ID of the treatment facility 

l. Organization – the organization that the treatment facility belongs to 

m. Org ID – ID of the organization 

n. Complaint – chief complaint 

o. DOD – patient date/time of death 

p. Discharged – patient discharge date/time 

q. Reported County – patient county sent in message data 

r. Disposition – patient’s discharge disposition 

s. Class – Emergency (E) or Outpatient (O) 

t. Encounter Reason – data sent as clinical reason for treating the patient 

u. Ethnicity – patient’s ethnicity 

v. Race – patient’s race 

w. Diagnosis – diagnosis sent 

 Points.csv – This file contains the number of registrations by admitted date (to represent 
the points on the graph) in a comma-separated file. 
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 Chart.png – This file contains an image of the downloaded graph. 

 

 
Bottom Frame of the EpiPlot Screen 

To Download Data: 

1. Select the desired graph parameters. 

2. (Optional) Select the Extended Format checkbox if you want the more robust data set 
shown above. Remember that the processing time can be significant, especially if your data 
range and other parameters are wide. 

3. Click the Download button at the bottom frame of the Epiplot screen. While processing 
completes, you can hover your cursor over the Cancel button (that replaces the Download 
button during processing) to see a running count of elapsed time. 

4. (Optional) To cancel the download, click the Cancel button that replaces the Download 
button during processing. A dialog window will confirm that the download was cancelled and 
the Download button will reappear. 

5. When the processing is complete, a dialog box confirms that the download is read. Click 
OK.  

 

6. The following screen then appears. Click the Save button. 
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7. Browse to the location where you would like to save the file and click the Save button. 

 

Additional Resources for Extended Downloads 

Links to relevant value sets: 

 Reported County  

o Value set: 
http://phinvads.cdc.gov/vads/ViewValueSet.action?oid=2.16.840.1.114222.4.11.829 

 Disposition (discharge)  

o Value set: 
http://phinvads.cdc.gov/vads/ViewValueSet.action?oid=2.16.840.1.114222.4.11.915 

 Class  

o Value set: 
http://phinvads.cdc.gov/vads/ViewValueSet.action?oid=2.16.840.1.114222.4.11.3404  
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E: Emergency (all emergency department visits); O: Outpatient (all urgent care visits) 

 Encounter Reason – may be free text or use Diagnosis value sets (see below) 

 Ethnicity  

o Value set: 
http://phinvads.cdc.gov/vads/ViewValueSet.action?oid=2.16.840.1.114222.4.11.837 

 Race  

o Value set: 
http://phinvads.cdc.gov/vads/ViewValueSet.action?oid=2.16.840.1.114222.4.11.836 

 Diagnosis  

o ICD-9 CM value set (code system I9CDX): 
http://phinvads.cdc.gov/vads/ViewValueSet.action?oid=2.16.840.1.114222.4.11.856 

o ICD-10 CM value set (code system I10C): 
http://phinvads.cdc.gov/vads/ViewValueSet.action?oid=2.16.840.1.114222.4.11.7356  

o SNOMED value set (code system SCT): 
http://phinvads.cdc.gov/vads/ViewValueSet.action?oid=2.16.840.1.114222.4.11.909 

o Diagnosis Type value set: 
http://phinvads.cdc.gov/vads/ViewValueSet.action?oid=2.16.840.1.114222.4.11.827  

A: Admitting; F: Final; W: Working 

 

Coded data element examples:  

 Ethnicity in coded format (Concept Code^Concept Name^Code System): 2135-2^Hispanic 
or Latino^CDCREC 

 Diagnosis in coded format (Concept Code^Concept Name^Code System^Type): 
J11.1^Influenza due to unidentified influenza virus with other respiratory 
manifestations^I10C^F 

 Disposition in coded format (numerical): 01 – corresponds to “discharged to home care or 
self care (routine discharge),” per value set 

 

Instructions for viewing the extended format download file: 

1. Select the very upper left corner of the grid (cell adjacent to “A” and “1”), and the entire grid 
will be highlighted 

2. From the “Home” menu, click the “Format” dropdown 

3. Select “AutoFit Column Width*” 

4. Select “AutoFit Row Height*” 

* It is important that the AutoFit be performed in this order 
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Mapplot 

The mapping functionality in MSSS is currently disabled. Instructions will be re-inserted into this 
User Guide when the functionality is enabled. 
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Alerts 

Alerts Screen 
Click the Alerts menu item from any page to access the Alerts functionality. The following screen 
appears. 

 

 
Alerts Screen 

Initially, the screen will be populated with alerts from the past 14 days.  
 
In order for an alert to be fired, the following conditions must be met: 
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 There must be at least one day in the period being checked (currently set to 120 days) 
where the total registrations were greater than 20.  

 There must be no more than 20 days of zero syndromic registrations in the period being 
checked (currently set to 120 days) for the syndrome being checked.  

 The normalized value for that given day must be greater than any of the past 14 days.  

 The actual normalized count for that day must be greater than 3.0 times the standard error 
plus the predicted normalized count. 

 An alert will not be fired if an alert for the same syndrome and region has been fired in the 
past 24 hours.  

 
Note that Heat is a seasonal syndrome that is different from other RODS-based syndromes and 
required a tailored solution for its alerting threshold. For this syndrome, there is a dual threshold of 
both a ratio based on historical visits (per 100) and a minimum lower boundary of 5 per county. The 
historical visit baseline was calculated per day, per county, and with a two-week averaging of 
these values around a given day when calculations are performed. 
 
In addition to the alerting characteristics shown above, alerts (syndromic conditions) exist in one of 
two states: discovered or sounded. A discovered condition is being monitored but is not currently in 
violation of the sounding rules. When the system discovers a condition in violation of one or more of 
the sounding rules, it moves to the sounded state, and an EpiAlert (e-mail) is generated. Every 
county-syndrome pairing is evaluated each hour. 
 
The time at which a condition is sounded is noted on the Chronology Chart, as are the rules that 
were in violation at any time during the monitoring interval (24 hours from discovery). Note that a 
violated rule will continue to be noted as violated for a given condition even if a change in 
calculations returns the rule to its normal state. 
 
The delta is the result of a calculation that compares—for a given county-syndrome pairing—the 
anticipated value (based on historic trends) to the current value (based on recently received patient 
encounters). A positive delta is considered abnormal. The sounding rules are each sensitive in 
different ways to the delta calculations: 

 Delta – Indicates that an abnormally large delta was discovered (> 15%). 
 Contiguous – Indicates that the delta has been positive for several calculations in a row (> 

4). 
 Escalations – Indicates that the delta has been growing for several calculations in a row (> 

2). 
 Elevated – Indicates that the delta has been positive for several potentially non-contiguous 

calculations across the monitoring lifetime (> 6). 
 
Each of these rules have configurable values that differ from the shown defaults, on a per-
syndrome basis. 

Alert Data: 

 Discovered – Date and time that the alert began being monitored  

 Sounded – Date and time that the alert violated conditions and generated an EpiAlert 

 Syndrome – The Syndrome the alert occurred for 

 Location – The county the alert occurred within (“Michigan” represents a state-wide alert) 
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 Observed – The Observed value is the observed normalized count for the alert. This value is 
the actual percentage of registrations in a region of a particular syndrome. For example, if 
there were 15 Rash registrations out of a total of 45 registrations, the observed normalized 
count would be 15/45 or 33%. This would be displayed as 33.33 in the Observed column. 
Hover your cursor over an Observed value to see details, as shown below. 

 

o Delta – The difference between the Extent and Threshold. 

o Extent* – The current ratio of syndrome-specific registrations to overall registrations 
within the alert's domain (county or state). Shown as a percentage. 

o Threshold* – The anticipated value for Extent, calculated from historic activity. 
Shown as a percentage. 

o Tainted – During the calculation of some alerts, their input data stream could have 
been deemed to be "tainted" by the tardiness of one or more historic contributors. 
Alerts with a non-zero tainted value will have their "observed" value shown in red to 
alert the analyst to this potential. In these cases, the "Tainted" value will also be 
shown and is the percentage calculated from the 30-day contribution of those tardy 
contributors, divided by the total 30-day contributions in the alert's domain (county or 
state).  

*The Extent and Threshold values that are shown in the tooltip are the values that were 
calculated during the segment of the alert when the Delta was at its widest. 

 Threshold – The Threshold value is the calculated threshold above which an alert would be 
signaled. This value is three standard deviations above the predicted value calculated by the 
system for the region in question. An alert will only fire if the observed value is above the 
threshold value. 

 Map It – The mapping functionality has been disabled. 

 Plot It – A link to the Epiplot screen where the alert is automatically charted. See Chronology 
Chart description below. 

 Tab It – A link that generates the alert chart in a separate window (rather than at the Epiplot 
screen). 

 Comments – This is a text entry field that allows you to store text associated with this alert. 
Note: This field has a maximum limit of 1024 characters. The text box only display first 20 
characters, the complete text will be displayed in the floating box when you mouse over the 
text inside text field. 

Chronology Charts 

Chronology Charts are a visualization of an alertable condition across its 24-hour lifespan. Each 
alertable condition, and thus each chart, is specific to a single Syndromic classification, and either a 
Michigan county or the entire state.  
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 Example Chronology Chart 

  
The Chronology Chart's primary feature is a "difference chart" that shows the spread between the 
anticipated values (threshold) and the current values (normalized). In general, a green area is good, 
and a red area is potentially an issue. The wider a "spread in red" becomes, the more likely an 
issue exists. The threshold values are calculated from historic behavior. The normalized values are 
calculated from the most recent 24-hour period. Normalization of both is performed using the overall 
number of visits in the domain (i.e., county or state).  
  
A "stacked bar" chart appears behind the "difference chart", and provides insight into the activity 
level within the domain. The overall "volume" series shows the overall domain registration volume, 
with the "syndrome" volume series on top of that. The "delayed" series could be present on top of 
each stack if the overall volume has been notably reduced by a delay from one or more contributors 
within the domain. The "delayed" series attempts to approximate the registration volume that 
was unavailable as the alertable condition was being monitored. It is a warning to the analyst to 
take into account as they are drawing conclusions about the condition. 
  
If the alertable condition violates one or more of the signaling rules (below), an EpiAlert message 
will be sent to a list of e-mail users, and the segment (hour) at which the alert was "sounded" will be 
indicated on the chart. The rules that have been violated at any time during the lifespan of the 
alertable condition will be shown in a subtitle of the chart. If the condition never violates the 
signaling rules during its 24-hour lifespan, then no message will be sent.   
  
Each of the signaling rules are configurable on a per-syndrome, or system-wide basis, and they 
refer to the number of segments (hours) in the chart where the difference chart is red. Their current 
settings are listed. The signaling rules are: 
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 Elevated – Series is red for more than 5 segments across the entire lifespan 

 Contiguous – Series is red for more than 3 segments in a row, anywhere in the lifespan 

 Escalations – The magnitude of the difference has increased 2 segments in a row 

 Delta – The magnitude of the difference is greater than or equal to 15% at any point in the 
lifespan 
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Sorting Alerts 
 

Initially, alerts are sorted by date/time stamp with the most recent alert appearing at the top. Alerts 
can be sorted by Syndrome, Date, County, Observed, or Threshold. 

 

 

Alerts Screen 

To Change the Sort: 

1. Click on the desired column header. Numerical columns sort numerically. Text columns 
alphabetically. Date/Time columns sort chronologically. 

Note: Click the same column header a second time to re-sort in the opposite order. 
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Mapping an Alert 
 

 

The mapping functionality in MSSS is currently disabled. 
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Graphing an Alert 
 

The Alerts page enables you to easily graph data related to an alert. 

 

Alerts Screen 

The Alerts page easily allows you to graph data related to an alert. 

To Graph an Alert: 

1. Decide which alert to graph. 

2. Click the Plot It link. 

3. The Epiplot screen appears and is loaded with data related to the selected alert. 
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Saving an Alert Comment 
 

The Alert Comments page is accessed from the Alerts screen and lets you save text associated 
with a particular alert. Note: The maximum length for the comment is 1024 characters. 

 

 

Alert Comments 

 

To Save/Edit an Alert Comment: 

1. At the Alerts screen, find the alert you wish to comment on. 

2. Click your cursor in the Comments field associated with the alert. The Alert Comments page 
appears. 

3. Type the desired text (up to 1024 characters). If editing, highlight the text to modify and type 
over it. 

4. Click the Save button when done. 
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Reports 

 

Reports Screen 
Click on the Reports menu item at the top of any screen to access the Report functionality. The 
following screen appears. 

 

Reports Screen 

Initially, the screen will be blank without a specified county. The report functionality allows you to 
view, print, and download syndromic reports for a specified county and time period.  

There are three reports available: 
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 Data Report – The Data Report is broken into three levels: State-Level, Facility-Level, and 
County-Level. The State-Level section provides state-level counts by syndrome for the 
specified time period. The Facility-Level section provides counts by facility by syndrome for 
the specified time period. The registrations included in the facility numbers are all 
registrations for that facility regardless of the patient’s home zip code. The County-Level 
section provides county-level counts by syndrome for the specified time period. The 
registrations included in the county numbers are all registrations where the patient’s home 
zip code falls within the specified county. 

 Graph Report – The Graph Report provides a graph for each syndrome (plus All Visits) for 
the specified county and time frame. 

 Alerts Report – The Alerts Reports provides a report of all the alerts that occurred within the 
specified county and time frame. Note: If an alert occurred that applies to all counties, it will 
be displayed as well with a County value of “All”. 

The Reports Screen is divided into three frames.  

 The top frame allows the user to specify the report parameters.  

 The middle frame is where the three reports will be displayed.  

 The bottom frame contain the report controls and allow the user to print reports, download 
reports, or view report specific help. 

Report Parameters: 

 County – This drop-down list allows the user to select a county. 

 Time Period – Pre-defined time periods (i.e. Last week, Last month, etc.) or a custom time 
period. 

 Start – Date to start pulling data. 

 End – Date to end pulling data (includes this day). 
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Viewing Reports 
 

You can view reports after specifying a county and time period. 

  

 

Reports Screen – Viewing a Report 

To View Reports: 

1. Select a county from the County drop-down list. 

2. Specify a time period: 

a. Time Period – Pre-defined time periods (e.g., Last Week, Last Month). Note: This will 
pre-populate Start and End. 

b. Start – Month, day and year to start pulling data. 

c. End – Month, day and year to stop pulling data (includes this day). 

3. Click the View button. 
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Note: While the reports are loading, a loading screen will appear. See the screen below. 

  

 

Reports Screen – Loading a Report 

When the reports are finished loading, you can view the different reports by using the vertical scroll 
bar on the right-hand side of the screen or you can use the three links under the reports 
parameters: Data Report, Graph Report, or Alerts Report. To jump to the top of the specified report, 
click on its associated link. 
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Printing Reports 
 

You can print reports once you view them. 

  

 

Reports Screen – Report Loaded 

To Print Reports: 

1. Select a county from the County drop-down list. 

2. Specify a time period: 

a. Time Period – Pre-defined time periods (i.e., Last Week, Last Month). Note: This will 
pre-populate Start and End. 

b. Start – Month, day and year to start pulling data. 

c. End – Month, day and year to stop pulling data (includes this day). 
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3. Click the View button. Note: While the reports are loading, a loading screen will appear. 
See the screen below. 

 

 

Reports Screen – Loading a Report 

When the reports are finished loading, click the Print button. The Print window appears. Select the 
desired printer and options then click the Print button. 

 

Print Window 



Michigan Syndromic Surveillance System User Manual November 2017  45 
 

Downloading Reports 
 

You can download reports after specifying a county and time period. Note: You can download 
reports without ever viewing them. The Download button enables you to save a copy of the reports 
to your hard-drive. A single file, named ReportDownload.zip, will be saved to the location you 
specify.  

 

Reports Screen 

The ReportDownload.zip file contains ten files with the following format: 

 Alerts_Report.csv – This file contains the Alerts Report in a comma-separated file. 

 Data_Report.csv – This file contains the Data Report in a comma-separated file. 

 Graph_Report_All.zip – This file contains the charts, plot-points, and the case 
information used to create the Total Visits graph of the Graph Report.  

 Graph_Report_Botulinic.zip – This zip file contains the charts, plot-points, and the 
case information used to create the Botulinic graph of the Graph Report.  
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 Graph_Report_Constitutional.zip – This zip file contains the charts, plot-points, and 
the case information used to create the Constitutional graph of the Graph Report. 

 Graph_Report_Gastrointestinal.zip – This zip file contains the charts, plot-points, 
and the case information used to create the Gastrointestinal graph of the Graph Report. 

 Graph_Report_Hemorrhagic.zip – This zip file contains the charts, plot-points, and the 
case information used to create the Hemorrhagic graph of the Graph Report.  

 Graph_Report_Neurological.zip – This zip file contains the charts, plot-points, and 
the case information used to create the Neurological graph of the Graph Report.  

 Graph_Report_Rash.zip – This zip file contains the charts, plot-points, and the case 
information used to create the Rash graph of the Graph Report.  

 Graph_Report_Respiratory.zip – This zip file contains the charts, plot-points, and the 
case information used to create the Respiratory graph of the Graph Report.  

 Graph_Report_Heat.zip – This zip file contains the charts, plot-points, and the case 
information used to create the Heat graph of the Graph Report. 

 Note: Each of the "Graph_Report_" zip files contain three files: Cases.csv, Points.csv, 
and Charts.png. 

o Cases.csv – This file contains the registration information the meet the selected 
criteria in a comma-separated file. The file contains the following information: 

 Admitted – admitted date/time 

 Facility – abbreviated name of the hospital 

 Assigned Zip – the assigned zip code (either the patient’s reported home zip 
if a valid Michigan zip or the treatment facility’s zip if not) 

 Reported Zip – the patient’s reported home zip code 

 Valid – a Y/N indicator as to whether the zip code is a valid Michigan zip code 

 Assigned County – the FIPS county code associated with the Assigned (i.e., 
perceived) Zip, so it is either the county code of the patient’s home address (if 
a valid Michigan zip) or the county code of the treatment facility (in the 
absence of a valid Michigan Zip for the patient). 

 Gender – M/F/U 

 Age – age at the time of admission 

 Syndrome – the syndrome classification 

 Provider – the treatment facility name 

 Provider ID – ID of the treatment facility 
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 Organization – the organization that the treatment facility belongs to 

 Org ID – ID of the organization 

 Complaint – chief complaint 

o Points.csv – This file contains the number of registrations by admitted date (to 
represent the points on the graph) in a comma-separated file. 

o Chart.png – This file contains an image of the downloaded graph. 

To Download Reports: 

1. Select a county from the County drop-down list. 

2. Specify a time period: 

a. Time Period – Pre-defined time periods (i.e., Last Week, Last Month). Note: This will 
pre-populate Start and End. 

b. Start – Month, day and year to start pulling data. 

c. End – Month, day and year to stop pulling data (includes this day). 

3. Click the Download button. Note: The File Download screen may take a few moments to 
appear. 

 

File Download Screen 

4. Click the Save button. The following screen appears. 
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Save As Screen 

 

5. Extract the files to your desired location. 
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Data Report 
 

To generate the Data Report, please refer to the Viewing Reports topic.  

 

Reports Screen – Data Report 

The Data Report is broken into three levels. Each level has the same four columns: Syndrome, 
Count, Normalized, and Daily Average. Each row in the table represents a syndrome (All represents 
total) and provides the count, normalized value, and daily average. 

 State-Level – The State-Level section provides state-level counts by syndrome for the 
specified time period. Sample State-Level section: 
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 Facility-Level – The Facility-Level section provides counts by facility by syndrome for the 
specified time period. The registrations included in the facility numbers are all registrations 
for that facility regardless of the patient’s home zip code. There will be one facility section for 
each facility within the county. The name of the facility will appear after the Report Header 
(Facility-Level). If no facilities exist within the selected county, then the report will note that 
no facilities exist. Sample Facility-Level section: 

 

 County-Level – The County-Level section provides county-level counts by syndrome for the 
specified time period. The registrations included in the county numbers are all registrations 
where the patient’s home zip code falls within the specified county. Sample County-Level 
section: 
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Graph Report 
 

To generate the Graph Report, please refer to the Viewing Reports topic.  

The Graph Report is similar to the Main screen of the system. It provides a graph for each 
syndrome (plus Total) for the specified county and time frame. The graphs shown in this report 
contain registrations that occurred in this county and time period where the patient’s home zip code 
fell within the county selected.  

 

Reports Screen – Graph Report 

Eight graphs appear: 

 All Visits – The graph includes all syndromes for all facilities within the county and time 
period. 

 Gastrointestinal – The graph includes all Gastrointestinal registrations for all facilities within 
the county and time period. 

 Constitutional – The graph includes all Constitutional registrations for all facilities within the 
county and time period. 

 Respiratory – The graph includes all Respiratory registrations for all facilities within the 
county and time period. 
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 Rash – The graph includes all Rash registrations for all facilities within the county and time 
period. 

 Hemorrhagic – The graph includes all Hemorrhagic registrations for all facilities within the 
county and time period. 

 Botulinic – The graph includes all Botulinic registrations for all facilities within the county and 
time period. 

 Neurological – The graph includes all Neurological registrations for all facilities within the 
county and time period. 
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Alerts Report 
 

To generate the Alerts Report, please refer to the Viewing Reports topic.  

The Alerts Report provides a report of all the alerts that occurred within the specified county (and 
alerts that apply to All counties) and time frame. The report is broken into two sections: Total and 
Detail. 

 Total – This section of the report provides a total count of the number of alerts that occurred 
within that county/time period for the given syndrome. 

 Detail – This section of the report provides a detailed list of alerts that occurred within the 
specified county/time period. The alerts are sorted in descending date/time order. This 
section provides the exact date/time the alert occurred, the county it occurred in (All 
represents an alert that applies to all counties), the observed value, the threshold value and 
any comments associated with the alert. 

 

 

Reports Screen – Alerts Report 
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Facility 

 

Facility Screen 
 

The Facilities page provides summarized and detailed information about the reception 
characteristics of registration data. The display is divided into an entity pane, synopsis/detail pane, 
and a control pane. For system efficiency, entity pane and synopsis content is generated by the 
server on a regular basis. Content provided to fulfill user selections of specific entities is generated 
on demand. Both entity and detail pane content are automatically refreshed in the user's browser at 
the same rate as it is generated on the server. 

Entity Pane 

The entity pane is on the left and can show one of three views: executive, facility, and organization. 
Each view exists in a circular queue in the aforementioned order. The location in the queue is 
controlled by the "entity" button in the control pane. The button's name will reflect the view that will 
be shown if it is clicked. Because all of the entity content is generated and then cached by the 
server, the overhead required to peruse this queue is insignificant. 

Executive View. Initially, the "executive" view is displayed in the entity pane. It provides a traffic-light 
metaphor regarding the transmission status of each facility, a facility name, the reception timestamp 
of its last registration, and a timestamp after which a given facility's transmission status will be 
considered questionable. Each facility name is an active link that, when clicked, will generate details 
about a given facility's transmission status and history. This content will be presented in the "detail" 
pane. 

The executive view can be sorted by each of its columns. The initial sort order is by the status 
column, which sorts by the descending difference between a given facility's deadline and its last 
reception timestamps (i.e., its transmission delta). The signal color is derived from the comparison 
of a given facility's transmission history and its current transmission delta. A "green" light indicates 
that registrations from a given facility are being received within an "acceptable" timeframe. A 
"yellow" light indicates that a given facility's transmission delta is outside its "normal" transmission 
timeframe, which could indicate a problem. A "red" light indicates that a given facility's transmission 
delta is alarmingly beyond its tolerance, and the integrity of its data link should be investigated by 
the support staff. Care must be taken when interpreting alerts, charts, and maps whose content 
involves "yellow" or "red" facilities. Three “black” lights indicate that the feed has been down for 
more than 30 days. 

Facility View. The "facility" view presents an active-content chart whose high-level interpretation is 
identical to that of the executive view. Green bars are for facilities whose transmission deltas are 
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within tolerance. Yellow bars are for facilities whose transmission deltas are beyond their "normal" 
transmission history. Red bars are for facilities whose transmission deltas are alarmingly beyond 
their tolerance and warrant investigation. 

The chart is arranged with each facility listed down the left side and an hours gradient across the 
top. The hours shown in the chart are relative to each facility's average transmission delta. Thus, 
negative values indicate a facility whose last registration reception, when compared to the time of 
the chart, was less than that facility's average. As such, we would anticipate that the majority of 
facilities will be seen to be shown relatively close to the average line most of the time (which is 
another diagnostic clue). The distance from the average line for most facilities is influenced by the 
FTP facilities whose average transmission deltas tend to be around 12 or 24 hours (and thus 
influence the scaling of the non-FTP facility displays). 

A tool-tip is provided for each facility when the mouse "hovers" over any part of its range. It displays 
the percentage over/under the calculated tolerance, the calculated tolerance, the 30-day volume, 
and average transmission delta (a.k.a. average response). Clicking in a facility's range will generate 
details about a given facility's transmission status and history. This content will be presented in the 
"detail" pane. 

The legend at the top of the chart identifies each of the elements used within the chart. A tool-tip 
containing a brief description of each element is provided when the mouse hovers over each 
element name. Each of these elements is defined below. 

The Range shows the minimum-to-maximum transmission delay from a given facility. It provides an 
"at a glance" view of a given facility's "normal" transmission pattern. For calculation accuracy, the 
range excludes "abnormal" transmission delays as defined by the report generation parameters. 

The Tardy bars are red to indicate a facility that is alarmingly beyond its calculated tolerance. The 
tolerance will vary with the reception history of a given facility, and is sensitive within this history to 
both the time of day, and the day of week. That is, the anticipated reception rate is different at 
3:00am on a Sunday than it is at 5:00pm on a Monday. 

The Active bars indicate a facility that is within its calculated tolerance. 

The Volume bars collectively form a "watermark" chart showing the contribution of registrations by 
each facility relative to its peers. 

The Average line provides an anchor at which each facility is normalized. This provides an "at a 
glance" determination as to how close a given facility is to its calculated reception average. It also 
provides a clean cross-facility comparison, and has a clarifying effect on the overall chart. 

The Tolerance mark indicates the high-water mark for the "normal" reception range. This is a per-
facility calculation and varies with a given facility's transmission history, time of day, and day of 
week. 

The Status mark indicates the current status of a given facility. If the Status mark is to the left of the 
Tolerance, then the facility is within its tolerance and its bar will be green. If the Status mark is to 
the right of the Tolerance, the facility is over its tolerance and will be either yellow or red, depending 
upon how far over tolerance it is. 

Organization View. The "organization" view is identical to the "facility" view in every way, except that 
it shows the transmission status of organizations rather than their individual facilities. This can be 
very helpful when attempting to diagnose suspected transmission failures. It can also afford insight 
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into the interpretation of alerts, charts, and maps. There are some organizations whose registration 
data is received from multiple sources. Thus, one or more facilities within an organization could 
show a tardy status when the organization its self does not. 

Synopsis/Detail Pane 

The synopsis/detail pane presents the parameters and a performance chart specific to either the 
overall system (synopsis) or an entity (i.e., a facility or organization). The default display is the 
system-wide synopsis page. It is generated at the same time as are the executive, facility, and 
organization views. Click on Facility in the top menu to restore the default view.  

The system-wide synopsis page provides the timestamp at which the synopsis and views were 
generated, the "data window" (i.e., how far back in time data was obtained for the calculations), the 
minimum tolerance for any entity (to minimize false alerts), and a high-water interval over which 
delays are ignored as "out of the norm" for calculation purposes. 

The detail pages provide the following content for the entity selected by the user: the organization 
name, the facility name(s), the municipalities in which each facility resides, the counties in which 
each municipality resides, the average transmission delta (delay), the calculated tolerance, the 
transmission delta since the last registration was received (current delay), the maximum 
transmission delta within the "data window," the volume received within the "data window", the 
average daily volume within the "data window", the timestamp of the last received registration, and 
the type of transmission (currently either VPN or FTP). 

For the Facility view, only the selected facility (i.e., not any "sister" facilities within its organization) 
are shown in the selected entity. For the Organization view, all facilities within the organization are 
shown in "latest" order. 

Both system-wide and detail pages also provide an EpiPlot chart specific to their respective 
domains. These charts reflect reception timestamps, not admission timestamps as is shown when 
using EpiPlot directly. They are advanced charts, having a moving average line and showing any 
relevant alerts in their timeframe (e.g., the system-wide chart only shows state-level alerts). The 
charts also have active content. The usual informational tool-tips are presented for registration and 
alert details. Clicking an alert will launch EpiPlot using the selected context for its initial chart. 
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Administration 

Administration Screen 
 

The Administration screen displays the current list of system users. It includes the user information 
such as login ID, name, role, status, jurisdiction, job title, and time of last login. It also associates an 
edit button with each user, which allows the administrator to update the information. 

Administration Screen 
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Administration Edit 
 

The Administration Edit screen allows administrators to update user information. Administrators can 
enter user names and addresses, assign roles, and enter other data. Updated information is stored 
in the database and allows users to log in next time with corresponding privileges. 

Note: For any roles other than Admin and MDCH, Jurisdiction must be assigned specifically. 

 

Administration Edit Screen 
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Logout  

 

Logout  
 

To log out from MSSS, you must first click Logout in the MSSS menu. You can then choose to log 
out from SOM MILogin. 

When you click Logout from the MSSS menu, the window closes but your MILogin session is still 
active. 

 

 

 
Logout Menu Item at MSSS 
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To end your MILogin session, you must also click LOGOUT here. 

 

LOGOUT Menu Item at MILogin 

You will be asked to confirm. Click Continue. 

 

LOGOUT Confirmation dialog 
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LOGOUT Confirmation 
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Glossary 

CoCo 
Chief Complaint algorithm that categorizes emergency room visits 

Epiplot 
Term used to refer to the graphing functionality within the Syndromic Surveillance 
System 

HL7 
Health Level Seven (HL7) is a standardized electronic data format 

MDHHS 
Michigan Department of Health and Human Services 

MILogin 
The State of Michigan single sign-on application 

RODS 
Realtime Outbreak Detection System 

Syndromic 
The classification of emergency room and urgent care visits into syndrome 
categories based on symptoms expressed in chief complaints 

 


